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Description 
Are you ready to unleash the full potential of Revit stairs? Stairs often receive a bad rap, but 
they are full of exciting possibilities! This hands-on lab will take you on a journey through the 
Revit stair toolset, where you'll learn to craft realistic, multi-story stair towers with confidence. 
We'll leverage the latest Revit features and explore how to create custom stair and railing types 
that not only meet building codes but also match industry standards and best practices. We’ll 
consider the entire package as we create the stairs, their railings and seamless landings. The 
result will be optimized to deliver on what is required for effective construction documents. If you 
want to raise your stair game to the next level, this is the lab for you! 
Speaker(s) 
Paul F. Aubin is an independent architectural consultant providing content creation, 
implementation, and training services to architectural firms worldwide. He is best known for 
authoring many Revit books like Renaissance Revit and dozens of video training courses on 
LinkedIn Learning, including the very popular Revit Essential Training. His career of nearly 35 
years includes experience in design, production, BIM management, coaching, reality capture, 
and training. Paul is a frequent top-rated speaker at many AEC industry conferences. He is an 
Autodesk Expert Elite, an Associate member of the AIA, and a member of the board of directors 
of the Volterra-Detroit Foundation. He lives in Chicago with his wife celebrating their three 
children as they foster their careers in cities around the country. 
View Paul’s profile on LinkedIn 

Learning Objectives 
• Go beyond the basics to create professional high-quality stair designs 

• Learn to deal with unique context conditions and make stairs that conform well to 
building geometry 

• Learn to make railings turn with stairs and follow the landings across multiple levels 

• Learn to create floors to mimic landings on multiple-story stair towers 
 

https://www.linkedin.com/in/paulaubin?trk=lil_instructor
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Starter file 
In this lab, we will be recreating Stair 3 from the Snowdon Towers Sample Architectural project 
that is included with Revit. This paper and lab will be conducted in Revit 2026.2. We will begin 
by opening two files: Snowdon Towers Sample Architectural.rvt, and the provided _Starter – 
Stair Tower.rvt project file. 

Open Files 
Start by opening Snowdon Towers.  

1. If Revit is not already running, launch it now.  

2. From the File menu, choose: Open > Sample Files. 

 
3. From Project Browser, open the view named: Transverse Section - Stair 3. Close other 

views. 

This is the stair we will be recreating. It is comprised of three stairs. A stair containing three runs 
from Parking level to level 1. A straight run stair from level 1 to 2. And a multistory stair from 
level 2 to the roof.  

4. Next open the provided _Starter – Stair Tower.rvt project file from the lab’s dataset files. 
Tile the views and zoom all to fit. 

This file has the shell of the stair tower and copies of all the levels. Please note that in the 
sample project, there is more than one level 1. The one we are using is called: L1 - Block 43. I 
have left the name in the starter file to avoid confusion when comparing it to the sample model.  

5. Close Snowdon Towers, but leave the Starter file open. 
Included Stair and Railing Types 
Before building the stairs, let’s explore the stair and railing types included with Revit. The 
Snowdon Towers sample model uses a steel plate stringer stair type. It uses a metal pipe railing 
with vertical balusters. Both of these types are included in the standard project template file 
included with Revit. For this lab, the starter model is based on the US Imperial version of this 
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template. (It is called: Imperial Multi-discipline in the New Project dialog). There is a metric 
version with similar types included. 
The easiest way to explore these types is to create a stair and railing using them.  

1. Open the L1 - Block 43 floor plan view. 

 
2. On the Architecture tab, click the Stair tool. From the Type Selector, verify that the type 

chosen is: Stair-Metal-Plate Stringer. Accept all other defaults. 

 
3. Within the crop region boundary of the floor plan, click a start point toward the bottom 

right, and then move straight up until all risers are used and click an end point. 

4. On the ribbon, click the Finish Edit Mode icon. 

 
5. On the QAT click the Default 3D View icon. And then zoom in on the new stair. 
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Explore the Stair Type 
If you are new to stairs, the first thing you will notice here is that the stair is comprised of more 
than one sub object. You can see this if you pre-highlight the stair, and then press TAB. Try this 
at the edge. When you do, you will be able to toggle between two components: Runs and 
Supports. The run contains the treads and risers and the supports are the stringers. Each of 
these components has its own type and settings. It should also be noted that we are using an 
“Assembled Stair” family here, which is why we see these specific components. Later there will 
be one more; the landing. There are two other stair families available: Cast-In-Place Stair and 
Precast Stair. We will not be considering those in this lab. 

1. Select the overall stair (not the runs or supports). 

Stairs are vertical elements like walls and columns and they share the height parameters of 
those other object types. You can set the height of your stair to span between any two levels 
and supplement these with Base and Top offsets to get the precise height required by your 
design. You can verify and change these heights on the Properties palette. 
Note also the Desired Number of Risers parameter. Revit will calculate the optimal riser height 
by dividing the Maximum Riser Height (in the Type Properties) into the overall stair height. 
Adjusting this value will have an impact on the riser height. 

2. Click the Edit Type button. 

 
The settings in the Calculation Rules area determine the slope of the stair and usually are 
configured to match what building codes require. For the purposes of this lab, we will leave the 
default 7/11 slope unchanged which is common in many jurisdictions. In your own projects, if 
you need to vary this, it is best to duplicate the type first and then make the required changes. 

Nested Styles 
Many of the settings in the Stair Type Properties dialog reference other types. You can identify 
these by clicking in the field and noting the small browse icon that appears on the right. 

 
We can think of these as “nested” types and one such nested type can be shared by more than 
one stair type. This is where you need to be careful. If you build a nested type for Supports as 
an example, and then use it on two different stair types, a change to that nested type will affect 
BOTH stair types.  



 
 

 

 
Page 5 

Let’s explore the nested types in this stair type. 

3. In the Type Properties dialog, in the Construction grouping, click in the field next to Run 
Type and then click the small browse button (pictured in the previous figure). 

Both the tread and riser thickness are set to ¼". The riser also has the “slanted” checkbox 
checked. And both items are assigned to a painted steel material. 

 
4. When you are finished studying these properties, you can click Cancel to dismiss the dialog 

without making changes. 

In the Supports grouping, three support sub-types are possible: Right, Left and Middle. To use 
Middle supports, you must check the box to enable it, and then you can input a quantity in the 
Middle Support Number field. For our purposes, we will not enable middle supports.  
 
Notice that both Right and Left Supports are using the same settings. This is an example of 
what was mentioned above. If a change is made to the settings in the nested type called: 
Stringer - 1/4" Plate, it will apply to both sides of the stair. However, before we study the settings 
of that type, note that the Right Support and Left Support parameters call from drop-down lists. 
This is a built-in list with three options. You can disable the support by choosing None. 
Otherwise, if you want a support, you choose between open or closed supports. Closed 
supports are stringers on the outside of the stair and open supports can be inset from the edges 
and support the stair from underneath. 

5. Click in the field next to Right Support Type and then click the small browse icon to open 
the Type Properties window for that nested type. 
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Take note of each of the dimensions in this window, but notice in particular that the stringers are 
the same thickness (¼") as the treads and risers. The two Structural Depth settings adjust how 
the stringer sits relative to the riser and tread. Along sloped sections (Runs), the Structural 
Depth On Run is used and is measured from the top of the stringer down to the intersection of 
the riser and tread. 
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The other setting only applies on Landing elements. 

6. No need to make any changes. Press Cancel all the way out. 

Explore the Railing Type 
Railing types contain one or more horizontally oriented members and can also contain repeating 
elements along the length of the rail. Railings also follow the slope of their host (such as a stair, 
floor or toposolid) or they can be simply sketched on a level. In general, the horizontal members 
tend to run parallel to the slope, while the repeating members tend to run vertically oriented 
(parallel to the Z direction).  
Horizontal members are referred to as “rails” and can be “continuous” rails or “non-continuous” 
rails. The difference between the two has to do with how the geometry is created. A non-
continuous rail will start and stop with each segment of the railing. A continuous rail will attempt 
to create a single continuous piece of geometry along the entire rail; much like a sweep.  
Continuous rails come in two varieties: Top Rails and Handrails. A railing type must have at 
least one horizontal member (rail). It can be any of the kinds mentioned. If a Top Rail is used, 
there can only be one. But in addition to or in place of a Top Rail you can have up to four 
Handrails and an unlimited number of Non-Continuous rails. 
Repeating members also come in two varieties: Balusters and Supports. Both use separate 
nested families to define the geometry of the element being repeated. Repeating patterns can 
be devised to add complexity and interest to a railing’s design. 
Like stairs, you can select the entire railing, or use the TAB key to reach in and select the sub-
components. 

 
Sub-component styles like Top Rails, Handrails and Baluster families can be used by more than 
one railing type, so as with stairs be aware of this and use caution when editing. 

1. Select the overall railing (not the rails or supports). 
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On the Properties palette, the Type Selector will read: IBC-Pipe-Plate Stringer (Extension Top 
and Bottom). This is the name of the railing type.  

2. Click the Edit Type button. 

In the Construction grouping you will find the settings for non-continuous rails and Baluster 
Placement. Above it was noted that you must have at least one rail. It can be any kind. This 
railing type does not use any non-continuous rails. So if you click the Edit button for Rail 
Structure (Non-Continuous) you will see that the dialog is empty. Cancel to return to the Type 
Properties window.  

3. Click the Edit button next to Baluster Placement. 

There are many possibilities in this dialog. For this railing however, it is quite simple. At the top 
you can see that the Main pattern consists of a single baluster family (Baluster - Round : 1") 
repeated every 4'-0". Everything else in this dialog is set to “None” and therefore does not apply 
to this design. 

 
If you wish to explore the baluster family, you must first exit out of the railing Type Properties 
dialog and then on the Project Browser, on the Families branch, expand Railings and then right-
click on Baluster – Round and choose: Edit. This will open it in the family editor where you can 
study its composition further if you wish. It is not necessary to do this to continue, but you are 
welcome to do so if you wish. 
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Continuous Rails 
Back in the Type Properties dialog for the railing, if you scroll down, you will see three groupings 
labeled: Top Rail, Handrail 1 and Handrail 2. To use a Top Rail, check the box and then select a 
type from the Type dropdown list.  
Handrail 1 and 2 are slightly different. To use one or both of them, you must select where you 
want them to be placed using the Position dropdown. The choices are: None, Left, Right and 
Left and Right. If you leave it set to None, the rail will not be used. Choosing Left, Right or both 
allows you add that rail in one or both positions. Since these options are available for both 
Handrail 1 and 2, you can end up with a total of four handrails (if you selected Left and Right for 
both Handrail 1 and 2). 

4. In the Top Rail grouping, click in the field next to Type, and then click the small browse 
icon. 

Under Construction, the shape of the top rail is determined by the Profile. In this case: Circular 
Handrail : 1 1/2". This is a dropdown list that contains any Profile families loaded into the 
project. You can choose a different shape by loading in an appropriate profile family. Hand 
Clearance shifts the profile laterally with respect the sketch line of the railing. The Default Join 
can be either Fillet or Miter. This one is set to Fillet with a 2" radius which makes the transitions 
smoother along the railing.  
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Looking at the railing design in the 3D model, you can see that the rails extend pass the ends to 
form railing extensions. This feature is only available for continuous rails. The settings in the 
Extension (Beginning/Bottom) and Extension (End/Top) control this. There are four Extension 
Styles that you couple with Length and the option of adding a Tread Depth. 

 
The railing type we have here uses three continuous rails. The top rail with the settings explored 
above and using a floor extension. Directly below this is Handrail 2 which also uses a floor 
extension. Handrail 1 is used a little unconventionally. Instead of being a true handrail, it is 
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positioned at the bottom of the railing design and aligned laterally with the top rail. Its extension 
style is set to None so that it terminates into the floor extension of the top rail.  

Supports 
The final feature utilized by this rail is that it uses Supports. Supports are nested families that 
repeat along the length of the rail. You can add supports to either Handrail 1 or 2. Top Rails and 
Non-continuous rails cannot use Supports. 

5. Click the browse icon next to Type for Handrail 1. 

6. Scroll down to Supports and note the settings. 

A family named: 2'-8" Picket is used here with a 4" spacing. If you want to open this family, you 
will need to exit the Type Properties dialogs and then locate the family on the Families branch of 
Project Browser. The family’s geometry is very similar to the baluster used in this railing. It is 
just a simple cylindrical solid element. Feel free to open and explore this family on your own. 

 
Now that you understand the settings used in the existing stair and railing types, it is time to 
start building the stair tower.  

7. Cancel all dialogs to return to the model canvas without making any changes. 
Create Stair A (Straight Run) 
Our stair tower will be comprised of three separate stairs. We’ll stack these within the stair tower 
to create the complete stairway. We’ll begin with the stair that goes from level 1 to level 2. Since 
we have already built such a stair, we can just modify it to fit our needs. 

1. Open the L1 - Block 43 floor plan view. 

The entryway to the building here on L1 is slightly higher than the level. So, we need to add a 
Base Offset to the stair. 

2. Select the stair created above. On the Properties palette, change the Base Offset to: 1 1/2". 

3. On the Modify tab of the ribbon, click the Align tool (or press AL). For the reference for 
alignment, click on the small reference plane in the stairway called: Stair A. 

4. For the entity to align, click the bottom edge of the stair. 

The result is pictured on the right side of the following figure. 
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Repeat the Align command. 

5. For the reference for alignment, click on the inside edge of the wall at the left of the 
stairwell. 

6. For the entity to align, click the left edge of the stair (make sure it is the stair and not the 
railing). 

The result is pictured on the right side of the following figure. 
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7. Open the Section Longitudinal building section view and verify the results. 

 
Please note that the section view has some text notes that summarize the properties required 
for the three stairs we will create: Stair A, B &C. 

8. Save the project. 

CATCH UP! If you get behind, look for these boxes. I have saved versions of the files at various stages of 
completion. You can open the file completed to this point named: 01 Stair A - Stair Tower.rvt. First, from 
the File menu, choose Close (or press CTRL + W). Then open the file indicated here. 

Create Stair B (Overlapping) 
As noted above, Assembled Stairs contain three possible nested subcomponents: Runs, 
Supports and Landings. Stair A is a simple straight run stair and therefore contains all its risers 
within a single run and has no landings. To create a stair with landings, you simple create runs 
that do not contain all the risers. In-between each run, Revit will add a landing.  

1. Open the Parking floor plan view. 

There are three reference planes here to assist us in placement: Stair B1 (to the right), Stair B2 
and Stair B3 (to the left). 
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We will use the reference planes to help place each run, but experience shows that it can be 
easier to exaggerate the shape of the stair initially to get the overall configuration correct and 
then come back and either mover or align the runs to finetune their placement. This is 
particularly true in this case since this will be a three-run stair that will wrap back on itself in 
plan. If you try to draw it that way initially, it can be very challenging. So first we’ll draw the runs 
outside of the stairwell on either side and then move them back in. 

2. On the Architecture tab, click the Stair tool. From the Type Selector, verify that the type 
chosen is: Stair-Metal-Plate Stringer. 

On the Properties palette, note that Revit assumes we want the stair to go from the Parking 
level to L1. Also notice that the Desired Number of Risers is calculated at: 29. However, recall 
above that we configured Stair A with a Base Offset of: 1 1/2". For our stair below to end up at 
this same location, we need to apply a similar offset to the new stair we are creating. 

3. On the Properties palette, for the Top Offset, input: 1 1/2". 

Notice that this adjusts the calculations and we now have a Desired Number of Risers of 30 
instead. 
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On the Options Bar, make sure that Automatic Landing is checked.  

4. Move your cursor so that it is highlighting Reference Plane: Stair B1 and then click outside 
to the right of the stairwell wall. 

5. Move straight down until the small gray message at the bottom reads: 10 RISERS 
CREATED, 20 REMAINING and then click to create the first Run. 

The run will appear outside the stairwell to the right, but its first riser will be aligned to the 
reference plane. 

6. Highlight Reference Plane B2 outside and to the left of the stairwell wall and click the first 
point of the next Run. 

7. Move straight up until small gray message at the bottom reads: 12 RISERS CREATED, 8 
REMAINING and then click to create the second Run. 
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As you work, the start and end riser number will be labeled on each Run. Also notice the 
automatically created Landing. We have one more Run to create. 
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8. Highlight Reference Plane B3 inside and about the middle of the stairwell this time and 
click the first point of the final Run. 

9. Move straight down until small gray message at the bottom reads: 8 RISERS CREATED, 0 
REMAINING and then click to create the third Run. 

The result is pictured on the right side of the following figure. 

 
Adjust Landing Shape 
Adjusting the landings can be a little tricky. If you move or align a landing, it will move the 
attached runs with it. But if you move or align a run, the landing will not move and will instead 
reshape accordingly. Alternatively, you can use the shape handles on the landing. To adjust the 
shape handles with precision, reference planes can be helpful. 

1. Toggle on Thin Lines (press TL). 

2. On the Modify | Create Stair tab, click the Reference Plane button (or press RP). 

3. On the Draw panel, click the Pick Lines tool and then on the Options Bar, input: 1/4".in the 
Offset field. 

4. Highlight the inside bottom wall edge (below the landing) and when the dashed line appears 
above and inside the stairwell, click to create the Reference Plane. 

You might need to zoom in because of the small distance. (And this is also why Thin Lines can 
help here). 

5. On the Options Bar, change the Offset value to: 1'-0" and then offset down from the line at 
riser 10. 
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If you zoom in closely, you will see that around the perimeter of the landing is a thin piece of 
material. These are the supports for the landing and as you recall from above, their thickness is 
¼". When we resize the landing, we want to ensure we have room for these supports and this is 
why we created the reference planes. In the next step, you can select the Landing and use the 
grip control handles and then snap them to the reference planes. 

6. Select the Landing element. 

Grip control handles will appear around its edges. 
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7. Using the grip control handle at the bottom of the Landing, stretch it down until it snaps to 
the reference plane that is just above the wall.  

8. Drag the middle control handle along the top edge of the landing and drag it down until it 
snaps to the reference plane beneath riser 10. 

To verify that the landing is correct, zoom out and make sure all the Runs are still located where 
you placed them, then select the Landing and verify that the temporary dimension that appears 
reads: 4'-6 1/2". Let’s adjust to top landing next. 

9. Repeat the process from above to create a new reference plane offset from the inside face of 
the top wall down: 1/4". 

10. Offset a second one up from riser 22 a distance of: 1'-6". 

 
11. Select the upper landing and using the grip control handles repeat the process from above to 

snap its shape to the reference planes. The Landing’s final width should be: 3'-10". 
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Positions the Run Elements 
Now we just need to move the three Runs into their proper positions. Remember that there are 
thin Supports on them as well. So, when you move them you have to take this small thickness 
into account. 

1. Select Run 3 (risers 23 – 30) and then using the Move tool (MV), set the start point at the 
right edge of the support (not the run). 

2. Move horizontally and then click the second point at the wall edge. 

 
3. Repeat that process to move the other two runs within the stairwell space. The two runs on 

the right side will overlap in plan.  
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4. On the ribbon, click the Finish Edit Mode button. 

If a warning appears, you can ignore it for now. We will address the issue later. 

5. Open the Section Longitudinal building section view and verify the results. 
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6. Turn off Thin Lines (Press TL). 

7. Save the project. 

CATCH UP! You can open the file completed to this point named: 02 Stair B - Stair Tower.rvt.  

Create a Multistory Stair 
The last stair we need to build is similar to the previous one, but it only switches back once. It 
will have two Runs connected by a Landing. Once we have the basic stair form, we will convert 
it to a multistory stair which will span the remaining levels to the roof. Let’s start with the basic 
switchback stair. 

1. Open the L2 floor plan view. 

We can see Stair A created earlier. Let’s hide it temporarily. 

2. Select the stair and both railings and then on the View Control Bar (bottom corner of the 
view window) click the Temporary Hide/Isolate icon (sunglasses) and choose: Hide 
Element. 

As before there are some reference planes here to assist us in placement: Stair C1 (to the right) 
and Stair C2 (to the left). 

3. On the Architecture tab, click the Stair tool. From the Type Selector, verify that the type 
chosen is: Stair-Metal-Plate Stringer. 

On the Properties palette, as before, Revit assumes we want the stair to go from the current 
level (L2) to the level above (L3). This time the Desired Number of Risers is being calculated at: 
19, and unlike the previous two stairs, we do not need a Top or Base Offset.  
To speed things up this time, we can adjust the Location Line and place the stair by snapping to 
the wall faces directly in place where is needs to go. 

4. On the Options Bar, for Location Line, choose: Exterior Support: Left. 
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5. For the first point of the Run, click the intersection between reference plane Stair C1 and 
the inside edge of the right vertical wall. 

6. Move straight down until small gray message at the bottom reads: 10 RISERS CREATED, 
9 REMAINING and then click to create the first Run. 

The result is pictured on the right side of the following figure. 

 
Repeat for the other run. 

7. Click the first point at the intersection of reference plan Stair C2 and the inside edge of the 
left vertical wall. 

8. Move straight up until small gray message at the bottom reads: 9 RISERS CREATED, 0 
REMAINING and then click to create the second Run. 



 
 

 

 
Page 24 

 
Let’s finish the stair. We’ll configure the landing later. 

9. On the ribbon, click the Finish Edit Mode button. 

If a warning appears, you can ignore it for now. We will address the issue later. 

10. Open the Section Longitudinal building section view and verify the results. 

 
11. Save the project. 

CATCH UP! You can open the file completed to this point named: 03 Stair C - Stair Tower.rvt.  

Enable Multistory Stairs by Adding Levels 
To create a multistory stair, you simply build a stair and then use the Select Levels tool to add 
additional levels. The stair configuration will be copied to those levels with the multistory stair 
element.  

1. Select the stair between L2 and L3 (the one just completed). 

2. On the Modify | Stairs tab, click the Select Levels button. 



 
 

 

 
Page 25 

The ribbon will change to the Modify | Multistory Stairs tab and the Connect Levels button will be 
active waiting for you to add additional levels to the stair. 

3. Using a crossing window selection box, select L4, L5, R2 and R3. 

4. Click the Finish button to complete the operation. 

 
You can ignore any warnings for now. 

Edit a Multistory Stair 
You can use the TAB key to reach in and select individual parts of the stair group. Stairs are 
grouped by height. So, any floor-to-floor heights that are the same will be part of the same stair 
group. And just like model groups, if you change one stair in the group, all will be impacted. 

1. Move your mouse near the multistory stair and note that it highlights like a group. 
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2. Select the multistory stair. Highlight the top stair (at R2) press TAB and then click. 

This will select the group that contains the top three stairs.  

3. On the ribbon click the Edit Stairs button. 

This will put you in edit mode on the bottom stair in the group. Any change made to this stair will 
apply to all three. 

4. Make a window selection around the whole stair (select landing, runs and supports). 

5. Move the stair to the left so that the bottom riser aligns with the stair on the level below. 
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6. Open the L3 floor plan view. 

7. Using the procedure from above, move the landing down so that it fills in the gap at the 
bottom wall. Remember to take the 1/4" thickness into account. 

8. Add a dimension from the face of the wall to the bottom of the run on both sides. Use your 
TAB key to ensure that the witness lines go from Wall to Run, not Supports or Landings. 

9. Select the Run on the right and then edit the temporary dimension to: 4'-8". 

10. Select the Run on the left and then edit the temporary dimension to: 5'-7". 
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11. Finish Edit Mode. 

12. Reopen the Section Longitudinal view. 

Notice how the change to the stair is applied to all three stairs within that height group. 
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13. Using the tab key, select the lowest stair in the multistory stair (the one at L2).  

14. On the ribbon, click Edit Stairs. 

15. Reopen the L2 floor plan view. 

16. Repeat the process from above to add a reference plane 1/4" from the bottom wall and then 
stretch the landing to snap to this reference plane.  

17. Finish the stair edit. 
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We need the topmost stair to be a little taller than the others in its group so that it can reach the 
roof deck materials. To do this, we can unpin it from the group. 

18. Highlight the topmost stair, press TAB and then press TAB again. When just the topmost stair 
is highlighted, click to select it. 

 
19. On the Properties palette, add a Top Offset of: 1'-1 5/16". 
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20. Save the project. 

CATCH UP! You can open the file completed to this point named: 04 Multistroy Stair - Stair Tower.rvt.  

Adjust Outside (Wall) Railings 
We are now ready to adjust the railings. When you create a stair, it automatically places a railing 
on each side for convenience, but you can change these as required by your design. For the 
railings along the walls, we want to swap those out with a different type – one that is mounted to 
the wall. In the center of the stairs, we will keep the existing railing type, but make some 
adjustments later.  

Wall Railing Type 
A wall mounted railing type already exists in this file. It is part of the original Revit template that 
was used to create this file.  

1. Open the L1 - Block 43 floor plan view. 

If you look carefully at the left-hand side of the plan, you can see that there are two railings 
there near the wall. 

2. Select the short vertically oriented rail that is next to the left wall. Do not select the one that 
goes all the way around the room.  

 
3. From the Type Selector (on the Properties palette), choose: Pipe-Wall Mount. 
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4. Open the Cutaway 3D view. Zoom and orbit as necessary to see the modified railing 
clearly. 

 
We need to add extensions to this railing type. 

5. Remaining in the 3D view, select the modified railing and then click the Properties palette, 
click the Edit Type button. 

6. In the Type Properties dialog, in the Handrail 1 grouping, click in the field next to Type 
(Pipe-Wall Mount) and then click the small browse button that appears. 

7. For both Extension Style settings, choose: Wall.  

8. For both Length settings, input: 1'-2 1/4". 

9. In the Extension (Beginning/Bottom) area, also check Plus Tread Depth. 

10. Click Apply. 
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The 3D view should update in the background when you Apply the changes. The extensions 
have been applied, but notice that the transitions on the original railing use rounded joins while 
this railing is using filleted ones. Let’s make a few more adjustments. 

11. Remaining in the Type Properties dialog for the Pipe-Wall Mount type, at the top, change 
the Default Join to: Fillet. 

12. For the Fillet Radius, input: 2". 

13. Change the Height to: 2'-10". 

 
14. Click OK twice to complete the modification. 
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Wall Railings in Multistory Stair 
We need the same railing applied to the wall railings on the floors above. But there, in addition 
to applying the newly modified type, we also need to modify the path sketch. They are also part 
of multistory stairs, height groups will apply here as well. 

1. Remain in the Cutaway 3D view, close all other views and then open the L2 floor plan. Tile 
the windows (press WT). Adjust the zoom as necessary. 

The L2 floor plan currently shows both the bottom stair (Stair C) of the multistory stair and the 
straight run stair (Stair A) of the level below. To make the next edit easier, let’s hide the stair 
below. 

2. Select the straight run stair (Stair A) and its railings in either view. In the floor plan view, at 
the bottom of the window on the View Control Bar, click the small sunglasses icon and 
choose: Hide Element. 
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3. In the floor plan view, select the railing along the wall. 

4. From the Type Selector (on the Properties palette), choose: Pipe-Wall Mount. 

There are three issues with this change. First, the rail has a gap where it returns to the wall. 
Second, it still wraps all the way around the landing instead of stopping and starting at each run 
and finally, if you look in the 3D view, it is likely that the vertical picket elements are still applied. 
Let’s take care of each of these, starting with the last one. (If your railing does not still show 
vertical pickets, you can skip this step). 
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5. Select the railing and from the Type Selector, choose: Railing 1. Be sure to apply it. 

This change will just be temporary. Railing 1 is a bare bones railing type that removes all 
customization. This removes the unwanted pickets, and will allow us to perform the next step. 

6. On the Modify tab of the ribbon, click the Split Element tool (or press SL). 

7. On the Modify | Split tab of the ribbon, check the Delete Inner Segment checkbox. 

8. Click the first point of the split below the stairs on the left side (just above the section cut 
line). 

9. Click the second point on the opposite side of the stairwell also just above the section cut 
line. 
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The railing will now be split into two railings. The portion on the left will no longer be visible in 
plan, but you can see it in the 3D view. The portion on the right is pictured to the far right in the 
previous figure. 

10. Select the railing on the right (in the plan view), click into the 3D view and then hold down 
the CTRL key and select the other railing visible there. 

11. From the Type Selector (on the Properties palette) change them back to: Pipe-Wall Mount. 

That should reapply the correct type without the pickets this time. A few final adjustments are 
needed. 

12. With the railings still selected, on the Properties palette, set the Offset from Path to: - ¼". 

This removes the gap at the wall connection. 

13. Select just the railing in plan. On the ribbon, click the Edit Path button. 

14. If you move your mouse over the magenta sketch path line you will see that it is two 
segments. Delete the lower one. 

15. Click the Finish Edit Mode button. 

16. Select the other railing in the 3D view. On the ribbon click the Edit Path button. 

17. Again delete the shorter segment that extends past the stair (lower in the plan view, left in 
the 3D view). 

18. Click the Finish Edit Mode button. 
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Remaining Wall Railings 
We need to repeat this process twice more for the railings above and then again for the one in 
the lowest level. When you select the next one up in the 3D view, it will highlight and select the 
two above. This is because they are part of the same height group in the multistory stair. So 
whatever you do in the edit will apply to both. 

1. Select the next railing up in the 3D view. Change it to type: Railing 1. 

2. Click in the floor plan view to make it active, and then open the L4 floor plan view. 

It will open as a new tab with the L2 plan. If it opens on top of the 3D view, drag its tab over to 
the plan tile instead. 

3. Modify the Offset from Path to: - ¼". 

4. Follow the Split element procedure above to split the railing into two. You may need to use 
your TAB key to ensure you are splitting the railing and not the nearby walls. 

5. Edit the path of each railing to remove the excess line at the landing (keeping just the line 
over the stair run). 

6. Select both railings and change them to: Pipe-Wall Mount. 
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7. Repeat for the stair at the top using the 3D view and plan R2. 

For the bottom-most railing, you need to repeat the process at each landing. You can do the 
lower landing in the Parking level plan. You can do the upper landing in the L1 – Block 43 plan. 
Otherwise, the steps are the same. 

CATCH UP! You can open the file completed to this point named: 05 Wall Railings - Stair Tower.rvt.  

Add Custom Landings (Floors) 
We still have adjustments to make to the inside railings, but let’s direct our attention to the 
landings first. Revit creates nice automatic landings between runs while modeling the stair. 
However, it does not make landings between separate stairs or at the levels in a multistory stair. 
In such cases, we must model these manually. We can do this with a simple floor element. If 
you recall what we learned in the “Explore the Stair Type” topic above, the stair treads, risers, 
supports and landings were all ¼" thick. Furthermore, the supports use a Structural Depth On 
Landing setting of 9". We can build a floor type that matches these settings. 
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Create a Floor Type 
We can start with a simple generic floor type and duplicate to create the one we need. 

1. On the Project Browser near the top, in the Search field, type: generic. 

The Project Browser will immediately filter to show items that contain that key word. 

2. Beneath Floors > Floor, right-click Generic - 12" and choose: Duplicate. 

3. This will create a new type named: Generic - 12" 2. Right-click this and choose: Type 
Properties. 
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4. In the Type Properties dialog, click the Rename button, change the name to: Stair Landing 
and then click OK. 

5. Next to Structure, click the Edit button. 

6. In the Edit Assembly dialog, change the Material to: Steel, Paint Finish, Dark Gray. 

7. Change the Thickness to: 1/4" and then click OK twice to complete the type modification. 

 
The Search prompt of generic will still be active in the Project Browser. To see the newly 
created type, you will need to clear this search. 

Create Custom Landings 
Now we can use this type to create our floor landing. 

1. Open the L1 - Block 43 floor plan view. 

2. On the Architecture tab, click the Floor button. Toggle on Thin Lines (press TL). 

3. On the Draw panel of the ribbon, verify that Pick Walls is active. 

4. On the Options Bar, input: 1/4" into the Offset field. 

5. Uncheck Extend into wall (to core). 

6. From the Type Selector, choose the newly created type: Stair Landing. 

7. For the Height Offset From Level, input: 1 ½". 
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8. Pick the two vertical walls of the stairwell and the one at the bottom (with the door), 

ensuring that the sketch lines go to the inside of the stairwell. 

You may need to zoom in to see this. 

9. Trim the corners using Trim/Extend to Corner (or press TR). 

 
10. On the Draw panel, switch to Pick Lines. Use your TAB key to ensure you are picking the 

edges of the Assembled Stair (not the railings) and then click the lines shown in the figure. 

11. Use a ¼" Offset for the riser line on the left side.  

12. Use Trim/Extend to Corner to complete the sketch. 
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13. Click the Finish Edit Mode button to complete the sketch. 

14. Reopen the Cutaway 3D view and turn off Thin Lines (press TL). 
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Create a Slab Edge Style 
To add stringers to the landing, we can use slab edges. We first need to make the appropriate 
type. Slab Edges use loaded Profile families. To save time, a suitable family has already been 
created and provided with lab’s dataset files. If you prefer to create your own, you can create a 
new Profile family from the default family template. Create a rectangular shaped profile ¼" wide 
by 12" tall. Make the insertion point at the upper left corner. 

1. On the Insert tab click the Load Family button. Browse to the folder with the lab’s dataset 
files. Choose: PRF_Rectangular (Bck Lft).rfa and then click Open. 

2. On the Architecture tab, click the Floor drop-down button and then choose: Floor: Slab 
Edge. 

3. On the Properties palette, click the Edit Type button. 

4. Click the Duplicate button and name the new type: Landing Stringer. Click OK. 

 
5. In the Type Properties dialog, for the Profile, choose: PRF_Rectangular (Bck Lft) : 

Landing Plate Stringer.  

6. For the Material, choose: Steel, Paint Finish, Dark Gray and then click OK. 

 
7. On the Properties palette, for the Vertical Profile Offset, input: 3". 

8. In the 3D view, click on the three edges of the landing floor draw above between the two 
stair runs. 
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To add the remaining edges. We’ll want to work in a different 3D view.  

9. Scroll up on the Project Browser, locate the Cutaway 3D view, right-click it and choose 
Duplicate. Rename this view as: Working. 

10. Select the landing floor element and then on the Modify tab, click the Selection Box tool 
(or press BX). 

The Working 3D view will have its crop region adjusted to the bounding box of the selected 
element. 

11. Orbit the view around so you can see the edges of the landing without slab edges.  

12. Return to the Slab Edge tool and add edges to the remaining sides. (Don’t forget to input 3" 
for the Vertical Profile Offset). 

 
Notice the way that the slab edge goes through the doorway. There are two solutions to this. 
You can click on the slab edge and use the grips to adjust it, and then add a new slab edge on 
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the other side. Or we can edit the landing floor sketch and break the sketch at the door. Let’s do 
the second approach. 

13. Select the floor landing element. On the ribbon, click the Edit Boundary button. 

14. Click the split tool, turn off (uncheck) Delete Inner Segment. 

15. Split the line at the door on each side of the jambs. 

 
16. Click Finish Edit Mode and then return to the Working 3D view. 

17. Select the existing slab edge and then on the ribbon, click the Add/Remove Segments 
button.  

18. Add the missing segment. 

For a finishing touch, you can use join geometry on the slab edge and the stair supports. 

CATCH UP! You can open the file completed to this point named: 06 Landings - Stair Tower.rvt.  

Adjust Inside Railings 
For the inside railings we need to make two adjustments. We’ll create and modify the railing 
types to fit the needs of the stairs we have. Also, we will need to create additional freestanding 
railings at our custom landings. 

Modify Railing Type 
We’ll begin by adjusting the railing types. 

1. Return to the Cutaway 3D view. 

The railing type we have in place now is not suitable for any of our specific situations. What we 
need is a version of this railing that has modified extensions that are suitable for the stair 
design. We’ll duplicate the existing type before modifying it to preserve the original. The trickiest 
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part of this process is remembering that there are two types to deal with. We need to duplicate 
the overall railing type, AND we need to duplicate the nested Handrail types that contain the 
extensions. So, pay close attention as you work. 

Duplicate Railing Type 
Let’s start with the lowest railing.  

2. Select the railing at the bottom of the stairwell. On the Properties palette, click the Edit 
Type button. 

3. In the Type Properties dialog, click Duplicate and call the new type: IBC-Pipe-Plate 
Stringer (Extension None). 

4. Beneath Top Rail, click in the Type field and then click the small browse button that 
appears to open a second Type Properties dialog. 

5. Duplicate this type and call it: IBC-Circular - 1 1/2" (Extension None). 

6. Change the Extension Style for both Beginning/Bottom and End/Top to: None. 

7. Change the Length for both to: 3". 

 
8. Click OK to accept the changes. 

9. Back in the railing Type Properties dialog, repeat the process for Handrail 2. 

10. Edit its type, duplicate it as: IBC-Handrail Circular - 1 1/2" (Extension None). 

11. Set both extensions to: None and 3" here as well. Click OK to accept the changes. 
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12. Click OK again to finish. 

In the model you will see the extension returns are now removed at both ends for the bottom 
stair. 

13. In the Cutaway 3D view, right-click one of the railings on the stairs on the upper floors, 
choose: Select All Instances > Visible in the View. 

14. From the Type Selector, choose the newly created type: IBC-Pipe-Plate Stringer 
(Extension None). 

Sketch Railing at Landing 
In place of the automatically generated extensions, we will sketch in new railings to create a 
smooth transition from floor to floor. 

1. Open the L1 - Block 43 floor plan view. 

2. On the Architecture tab, click the Railing drop-down and choose: Sketch Path. 

3. Sketch the path as indicated in the following figure. The sketch lines are lined up with the 
midpoints of the Top Rails of the existing railing and they are set 3" away from their ends 
as shown. 

 



 
 

 

 
Page 49 

There is a handy checkbox on the ribbon which can be very helpful while sketching. Toggle on 
the Preview checkbox to see what the railing will look like before you are finished sketching. 
(Shown on the right side of the figure). 
If you return to the Cutaway 3D view, the railing will appear too low. Remember that at the first 
floor, we need and offset of 1 ½".  

4. On the Properties palette, for the Base Offset, input: 1 ½". In the warning that appears, 
simply click OK. 

 
CATCH UP! You can open the file completed to this point named: 07 Middle Railings - Stair Tower.rvt.  

Wrapping Up 
That’s as far as we are going to take it here in this lab. If you want to finish the stair tower, you 
can create the remaining landings and railings using the same procedure. You should only need 
to create one more at L2 and then copy and paste it to the other levels and fine tune as needed. 
If you want to see the finished version, you can reopen the Snowdon Towers Sample 
Architectural.rvt model mentioned at the start of the session. We have been working on Stair 3. 
But feel free to explore the other stairs in the model as well. Each one is slightly unique. 

RE-OPEN THE SAMPLE MODEL! To re-open Snowdon Towers, choose: File > Open > Sample Models and 
then open: Snowdon Towers Sample Architectural.rvt. 
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Thanks for joining the lab today! 
 
Follow me on LinkedIn: 
www.linkedin.com/in/paulaubin 
 
Check out my courses on LinkedIn Learning: 
https://www.linkedin.com/learning/instructors/paul-f-aubin  
 
Please visit: 
www.paulaubin.com  

https://www.linkedin.com/in/paulaubin/
https://www.linkedin.com/learning/instructors/paul-f-aubin
http://www.paulaubin.com/
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